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Instructions — Delete Before Publication 93 

1. How to use this template (general instructions) 94 

1.1 General 95 

Use this template for DMTF profiles based on the Management Profile Specification User 96 
Guide1.1(DSP1001), specifications, or white papers. These instructions explain how to use the template 97 
in Word 2007. Subsequent clauses explain how to modify the template for a profile, specification, or white 98 
paper. 99 

1.2 Storing the template (.dotx) file 100 

You must store this .dotx file in a certain folder to ensure that it is available through Word when you want 101 
to create a new document.  102 

To determine where to store template files, follow these steps: 103 

1) Click the Office button (upper left), and click the Word Options button. 104 

2) In the left pane, click Advanced. 105 

3) At the bottom of the dialog, click File Locations. 106 

4) Select "User templates" to see the path where Word stores and looks for templates. 107 

This is the path where you should store the .dotx file. If you store the file in this directory, the next time 108 

you start Word and click the Office button New and select Templates…my templates in the left pane, 109 
you can select this template to start a new document. 110 

1.3 Ensuring that your document uses the template 111 

To use the functionality provided by the template, use one of the following approaches: 112 

 Start the new document by using the template (as described in 1.2 in these instructions).  113 

 Attach the template file to a document (.doc) file. For instructions about how to attach the 114 
template and ensure that your document includes the styles used in the newly attached 115 
template, see 1.5 and 1.6 below.  116 

1.4 Using the optional macros template  117 

This subclause explains why and how to use the optional macros template. 118 

1.4.1 Why use the optional macros template 119 

A separate template (DSP1000macros_m.n.u.dotm)that provides macros is available to use with this 120 
template. This optional macros template provides the following functionality: 121 

 A streamlined method for inserting numbered captions for figures, tables, and equations 122 

 A button to toggle line numbering on or off 123 

 For styles such as Notes and Examples, the macros fill in the label (for example, NOTE or 124 
EXAMPLE) and provide automatic numbering for numbered notes or examples. 125 
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 If automatic numbering is not working properly for your document, you can use one of the 126 

macros provided to reset heading and list numbering. (Click Misc. Commands  Reset 127 
Heading/List Numbering.)  128 

1.4.2 How to apply the optional macros template as a global template 129 

You can take advantage of the macros by applying the macros template (DSP1000macros_m.n.u.dotm) 130 
as a "global template" on top of this template (DSP1000_m.n.u.dotx); with this method, macros are not 131 
applied as a document template. 132 

Macros from a document template are not copied into the new document to which the macros template is 133 
attached. However, when the macros template is applied as a global template, these macros become 134 
available. 135 

After applying the macros template as a global template, enabling or disabling the macros for a document 136 
is as easy as turning the check mark on or off in the templates dialog. Having that checkmark turned off 137 
avoids prompts when opening and closing a document. 138 

Selecting and enabling a global template affects any document currently open in Microsoft Word. Make 139 
sure to disable the DSP1000macros_m.n.u.dotm template before closing the document or closing 140 
Microsoft Word, or the macros template will affect any new document you start or open. 141 

1.4.2.1 Enable the DSP1000macros_m.n.u.dotm global template 142 

To use the macros, you must enable the macros template. Follow these steps: 143 

1) Click the Office button (upper left), and then click the Word Options button. 144 

2) In the left pane, click Add-Ins. 145 

3) In the Manage pull-down menu at the bottom, select Templates and click Go... 146 

4) Click Add … 147 

5) Navigate to where the DSP1000macros_m.n.u.dotm template file is stored. 148 

6) Select DSP1000macros_m.n.u.dotm, and click OK. 149 

7) On the Templates and Add-ins dialog, click OK. 150 

1.4.2.2 Disable the DSP1000macros_m.n.u.dotm global template 151 

To disable the macros template, follow these steps: 152 

1) Click the Office button (upper left), and then click the Word Options button. 153 

2) In the left pane, click Add-Ins. 154 

3) In the Manage pull-down menu at the bottom, select Templates and click Go... 155 

4) Uncheck the checkbox for DSP1000macros_m.n.u.dotm, and click OK. 156 

1.5 Attaching the DSP1000_m.n.u.dotx template to an existing document 157 

1) Click the Office button (upper left), and then click the Word Options button. 158 

2) In the left pane, click Add-Ins. 159 

3) In the Manage pull-down menu at the bottom, select Templates and click Go... 160 

4) Click the Attach button.  161 

5) Select the appropriate .dotx file that you want to attach. (If you stored the .dotx file in the proper 162 
destination folder as described in 1.2 in these instructions, it should be listed among your 163 
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template files and you won't have to browse for it.) Make sure the "Automatically update 164 
document styles" box is not checked. 165 

6) Click OK. 166 

1.6 Using the organizer to copy the template styles to your document 167 

1) Click the Office button (upper left), and then click the Word Options button. 168 

2) In the left pane, click Add-Ins. 169 

3) In the Manage pull-down menu at the bottom, select Templates and click Go... 170 

4) Click the Organizer button in the lower left corner of the dialog.  171 

5) On the right side of the Organizer dialog box click Close File; this button label changes to Open 172 
File.  173 

6) Click the Open File button.  174 

7) Traverse to the correct directory and select the DMTF template. Click Open. 175 

8) In the list of styles in the window on the right side (under the DMTF template name), click on the 176 
"code" style (a few styles down from the top) and use the scroll bar to scroll down to the end of 177 
the list of styles. Hold down the shift key and click on "zzSTDTitle". Click on the << Copy button. 178 
Select the "Yes to All" button when asked to overwrite existing styles.  179 

9) Click Close. 180 

1.7 Using the variables defined in the template 181 

The template uses a number of fields associated with the document’s properties to populate elements in 182 
the title page, headers, footers, and other places in a document.  183 

You can change the values for any of these fields by modifying the document’s properties. To change the 184 
value for a particular field, follow these steps: 185 

1) Click the Office button (upper left), and then select Prepare → Properties. 186 

2) Click the down arrow next to Document Properties and select Advanced Properties. 187 

3) Click the Custom tab. 188 

4) Click the name of the field in the Properties list in the bottom half of the dialog, and then modify 189 
the string in the Value field. 190 

5) Click Modify to save the change. 191 

6) Repeat steps 4 and 5 for each property whose value you want to change. 192 

7) When you have finished modifying properties, click OK. 193 

If you change a value for a field, the change will be propagated the next time you update the document. 194 
For details on updating the fields in a document, see 1.8 below. 195 

All of the custom properties are listed in the following table:  196 

 197 

Custom Property (Variable) Name Description Used In 

DocTitle Document title, which will be displayed on the 
title page and in the page headers 

All documents 

DocNumber Document number, which will be displayed on 
the title page and in the page headers 

All documents 
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Custom Property (Variable) Name Description Used In 

DocVersion Published version of the document, which will 
be displayed on the title page and in the page 
footers. See DSP4004 for guidelines about 
version numbers, including the conventions 
for specifying draft level with letters. 

All documents 

DocType The document type, as follows: 

Use “Specification” for all standards 
documents (including profiles).  

Use “White Paper” for white papers. 

Use "Process" for process documents. 

This list is the subset of document types 
covered by this template. See DSP4004 for 
the complete list of document types. 

All documents 

DocStatus This is the document status, which will be 
displayed on the title page and in the page 
footers (directly before the DocConfidentiality 
variable). The DocStatus values are as 
follows: 

In Development 

Work in Progress 

DMTF Draft Standard 

DMTF Standard 

DMTF Informational Specification 

DMTF Informational 

See DSP4004 for the complete list of values 
for this property. 

All documents  

DocLang This property is the document language. For 
DMTF documents, the value for this property 
shall be “en-US” for U.S. English. (This value 
is a combination of language code as defined 
in ISO 639-1/2/3 and country code as defined 
in ISO 3166-1/2/3.) 

All documents 

DocConfidentiality This property is displayed in the center of the 
page footers and directly follows the 
DocStatus property.  

During document development and the DMTF 
approval process, the value of this variable 
should be "DMTF Confidential ". 

For Work in Progress documents that are 
under development, this property should read: 
“  – Not a DMTF Standard – DMTF 
Confidential”. 

After a document is released, the value of this 
variable should be an empty string, except for 
Work in Progress documents where the value 
should be:  
“– Not a DMTF Standard” (directly following 
the DocStatus value of “Work in Progress”; 
insert a space before the dash so the 
DocConfidentiality value works correctly with 
the DocStatus value). 

All documents 

http://www.dmtf.org/standards/published_documents/DSP4004_2.2.0.pdf
http://www.dmtf.org/standards/published_documents/DSP4004_2.2.0.pdf
http://www.dmtf.org/standards/published_documents/DSP4004_2.2.0.pdf
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Custom Property (Variable) Name Description Used In 

DocCompTitle This is the optional document complementary 
title. For document titles that have two parts, 
this is the second part of the title. 

Specifications or white 
papers, if needed 

DocOwningWG This is the DMTF working group or editing 
body that has authored the document. Include 
the full name of the working group or editing 
body in the value for this property; do not 
abbreviate the name. 

All documents 

DocRegisteredName This is the profile’s RegisteredName value. Profiles only 

DocWorkGroupVersion This is the optional Working Group version 
number, which some WGs use to keep track 
of their internal version number during 
document development. If included, the value 
for this variable is displayed under the Version 
number on the title page. ( This line must be 
deleted from the title page before a 
specification is published (as a Work in 
Progress or DMTF Standard), or sent to 
member review (as a DMTF Draft Standard). 

All documents 

1.8 Updating properties and fields in a document 198 

You can update either a single value or all of the values for a document’s properties or fields. 199 

1.8.1 To update the value for a single field 200 

To update the value for a single field (for example, the version number in a page footer), follow these 201 
steps: 202 

1) Select the text that you want to update. 203 

2) Right click and select Update Field. 204 

1.8.2 To update all of a document’s properties and fields 205 

To update all of a document’s properties and fields (as well as the Table of Contents, Figures list, and 206 
Tables list), follow these steps: 207 

1) Open the document.  208 

2) Either press Ctrl-A or click three times in the left margin to highlight all of the text in the 209 
document. 210 

3) Right click anywhere within the highlighted text and select Update Field.  211 

4) Various windows are displayed that allow you to update either just the page numbers or both 212 
the page numbers and text in the various generated lists that are included in your document 213 
(Table of Contents, Figures list, and Tables list). To update these lists: 214 

– In the Update Table of Contents window that is displayed, select the Update entire table 215 
option. 216 

– In the Update Table of Figures window, select the Update entire table option. 217 

– In the Update Table of Tables window, select the Update entire table option. 218 

5) Look for broken references by searching for “Error!” and correct them as needed. 219 
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1.9 Using bookmarks and hyperlinks for references to other documents 220 

Within the body of a profile or specification, all references to other documents should be hyperlinked back 221 
to the list of references in Clause 2 ("Normative References") or to the Bibliography rather than to the 222 
actual source document on the Web. Each document in the reference list or Bibliography contains a URL 223 
with a hyperlink to the source document on the Web. The URL for each reference should be visible in 224 
each reference (for example, http://www.dmtf.org/standards/published_documents/DSP1033_1.0.pdf). 225 
Links to actual documents (through URLs) should appear only in the list of references or the Bibliography. 226 
With this approach, updates to referenced documents’ version, date, or URL need to be made in only one 227 
place. 228 

To facilitate this approach, insert a bookmark for each document in the list of references. You can then 229 
add a hyperlink back to this bookmark from each reference in the body of the document. The following 230 
subclauses provide instructions for how to create bookmarks and hyperlinks, as well as conventions for 231 
bookmark names. 232 

1.9.1 To add a bookmark 233 

To add a bookmark, highlight the text (such as a document title) that you want to link to. Go to Insert → 234 
Bookmark. Provide a bookmark name according to the conventions described in 1.9.3 in these 235 
instructions. 236 

1.9.2 To add a hyperlink 237 

Hyperlinks can link either to a point within the document or to a document on the Web.  238 

To add a hyperlink that references a point within the document (such as a document title within the list of 239 
normative references or in the Bibliography): 240 

1) Highlight the document name or number where you want to insert a hyperlink.  241 

2) Go to Insert → Hyperlink, and from the Link to: list on the left, select Place in This Document.  242 

3) In the window, scroll to the bottom for the list of bookmarks that you can link to and select the 243 
appropriate bookmark. 244 

To add a hyperlink that points to a document on the Web: 245 

1) Highlight the document name or number for which you want to insert a link.  246 

2) Go to Insert → Hyperlink, and from the Link to: list on the left, select Existing File or Web Page.  247 

3) In the Address field near the bottom of the dialog, type or paste the destination URL for the 248 
document or Web site. 249 

1.9.3 Conventions for bookmarks 250 

Adhering to bookmark naming conventions facilitates copying/pasting of bookmark references from one 251 
document to another if the respective bookmark definition is already in the target document. 252 

When creating bookmarks, use the following conventions for the bookmark name: 253 

 Use "Ref_DMTF_DSPxxxx" for DMTF specifications. 254 

 Use "Ref_<ORG>_xxxx" for non-DMTF specifications. 255 

 Use "Term_<termword1>”, ”Term_<termword2>”, etc. for terms and for symbols and 256 
abbreviated terms. 257 

NOTE  Do not include versions or dates in bookmark names. 258 

http://www.dmtf.org/standards/published_documents/DSP1033_1.0.pdf
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2. Using this template to create a DMTF profile 259 

This template is optimized for profile development using the Management Profile Specification User 260 
Guide DSP1001 1.1. To create a profile using this template, refer to DSP1001 ver 1.1 and follow these 261 
steps: 262 

1) Fill in the variables (custom properties) as described in 1.7 in these instructions. Fill in the 263 
document title for the DocTitle field, and fill in values for all other fields that are not optional. 264 

2) Delete the “Abstract” clause because it is used only for white papers. 265 

3) Add or delete information in the “Foreword” and “Acknowledgments” sections as necessary. 266 

4) Add or delete text in the “Introduction”. 267 

5) Fill in text for the “Scope”. 268 

6) In Clause 2, “Normative References”, insert any additional references that are needed, using 269 
the format of the references already included. 270 

7) In Clause 3, add terms and definitions for your document. 271 

8) In Clause 4, add any abbreviated terms and their spelled-out versions.  272 

9) Fill in Clauses 5–10 according to DSP1001. Note that the fields in the beginning of Clause 5 will 273 
be filled in with the values you entered for the custom properties. 274 

10) Use the Annex placeholder if you have material for one or more Annexes. In each Annex title, 275 
indicate whether the annex is Informative or Normative. 276 

11) Fill in the Change Log to capture progress. The Change Log should include only one row for 277 
each published release. The Change Log should be the last Annex before the Bibliography. 278 

12) Fill in any entries for the Bibliography. If you have no documents to include in the Bibliography, 279 
delete it. The Bibliography is not an annex and should not be labeled as an annex. 280 

13) Delete the “Instructions” section (all of this green text). 281 

14) If your document is not a Work in Progress, delete the Work in Progress box (visible in the Print 282 
Layout view) from the title page. 283 

15) Update all fields in the document as described in 1.8.2 in these instructions. 284 

3. Using this template to create a DMTF specification 285 

Only the first few clauses (through Clause 4) and the Annexes/Bibliography of this template are relevant if 286 
you're creating a DMTF specification. To create a specification using this template, follow these steps: 287 

1) Fill in the variables (custom properties) as described in 1.7 in these instructions. Fill in the 288 
document title for the DocTitle field, and fill in values for all other fields that are not optional. 289 

2) Delete the “Abstract” section because it is used only for white papers. 290 

3) Add or delete information in the “Foreword” and “Acknowledgments” sections as necessary. 291 

4) Add or delete text in the “Introduction”. 292 

5) Fill in text for the “Scope”. 293 

6) In Clause 2 “Normative References,” delete any references that don’t apply. (The boilerplate list 294 
of references applies to DMTF management profiles, so some of these references might not be 295 
appropriate for your specification. Retain the reference to the ISO Directives because it applies 296 
to all DMTF documents.) Insert any additional references that are needed, using the format of 297 
the references already included.  298 

7) In Clause 3, add terms and definitions for your document. 299 
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8) In Clause 4, add any abbreviated terms.  300 

9) Delete Clauses 5–10, because they contain boilerplate text that is specific to profiles (based on 301 
DSP1001 1.1). 302 

10) Use the Annex placeholder if you have material for one or more Annexes. In each Annex title, 303 
indicate whether it is Informative or Normative. 304 

11) Fill in the Change Log to capture progress. The Change Log should include only one row for 305 
each published release. The Change Log should be the last Annex before the Bibliography. 306 

12) Fill in any entries for the Bibliography. If you have no documents to include in the Bibliography, 307 
delete it. The Bibliography is not an annex and should not be labeled as an annex. 308 

13) Delete the “Instructions” section (all of this green text). 309 

14) If your document is not a Work in Progress, delete the Work in Progress box (visible in the Print 310 
Layout view) from the title page. 311 

15) Update all fields in the document as described in section 1.8.2 in these instructions. 312 

4. Using this template to create a DMTF white paper 313 

Only the first few sections (through Clause2) and the Annexes/Bibliography of this template are relevant if 314 
you're creating a DMTF white paper. To create a white paper using this template, follow these steps: 315 

1) Fill in the variables (custom properties) as described in 1.7 in these instructions. Fill in the 316 
document title for the DocTitle field, and fill in values for all other fields that are not optional. 317 

2) In the “Abstract” section, briefly describe the purpose and the intended audience for the white 318 
paper. 319 

3) Add or delete information in the “Foreword” and “Acknowledgments” sections as necessary. 320 

4) Review the “Introduction” section, and delete any sections that aren’t relevant. If you use any 321 
document conventions, list them here. If you don’t use conventions, delete the “Document 322 
conventions” section. 323 

5) Change the “Scope” heading to “Executive Summary”, and add summary information in this 324 
section. The Executive Summary should be no longer than one page. 325 

6) Delete Clause 2 “Normative References”. 326 

7) In Clause 2 ("Terms and definitions"), add terms and definitions for your document .Each term is 327 
a numbered subclause that is created by using the Term – Ref Num style (followed by the Term 328 
– Name and Term – Definition styles). 329 

NOTE You must adjust the numbering of the first term so that the first part of the term heading number 330 
matches the number of the preceding clause. By default, the list of terms starts with 3.1 because the 331 
"Terms and definitions" clause is typically Clause 3. If your "Terms and definitions" clause is Clause 2, 332 
there will be a mismatch. To adjust this, right click in the first “numbered” paragraph under the “Terms and 333 
definitions” heading. Select “Numbering” and then select “Define New Number Format” from the list that 334 
pops up; change the first part of the number (3) to match the number of the preceding main clause 335 
(probably 2). Click OK. The first number of the term number should now match the preceding clause 336 
number. 337 

8) In Clause 3 ("Symbols and abbreviated terms"), add acronyms or other abbreviations used in 338 
your document. Each abbreviation is a numbered subclause created by using the Term – Ref 339 
Num style (followed by the Term – Name and Term – Definition styles). Delete Clause 3 if you 340 
don't have any symbols or abbreviated terms. (See NOTE above for a tip about numbering.) 341 

9) Delete Clauses 4–10 because they contain boilerplate text that is specific to profiles (based on 342 
DSP1001 1.1). 343 

10) Add new clause headings and clauses as necessary. 344 
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11) Use the Annex placeholder if you have material for one or more Annexes. In each Annex title, 345 
indicate whether it is Informative or Normative. Otherwise, delete the annex placeholder.  346 

12) Fill in the Change Log to capture progress. The Change Log should include only one row for 347 
each published release. The Change Log should be the last Annex before the Bibliography. 348 

13) Fill in any entries for the Bibliography. If you have no documents to include in the Bibliography, 349 
delete it. The Bibliography is not an annex and should not be labeled as an annex. 350 

14) Delete the “Instructions” section (all of this green text). 351 

15) If your document is not a Work in Progress, delete the Work in Progress box (visible in the Print 352 
Layout view) from the title page. 353 

16) Update all fields in the document as described in 1.8.2 in these instructions. 354 

5. Guideline for using capital letters in headings and figure and table titles 355 

The Technical Committee recommends using sentence-style capitalization in headings, figure titles, and 356 
table titles. In other words, only the first letter of the heading or title should be a capital letter (except for 357 
class names and other words that use a capital letter regardless of the context). 358 

6. Document footers 359 

A document's status dictates the text that should be included in a document's page footers, as follows: 360 

 361 

Document status Required text in footer 

In Development In Development — DMTF Confidential 

Work in Progress (in Development) Work in Progress — Not a DMTF Standard — DMTF Confidential 

Work in Progress (published) Work in Progress — Not a DMTF Standard 

DMTF Draft Standard DMTF Draft Standard — DMTF Confidential 

DMTF Standard DMTF Standard 

DMTF Informational Specification This Informational Specification is not a DMTF Standard and may change. 

DMTF Informational DMTF Informational 

7. Helpful Hints for Figures and Tables 362 

7.1  Figures 363 

Sometimes inserting .jpg files into a Word document yields fuzzy figures. For class diagrams and other 364 
figures, use this procedure so that your figures have higher resolution: 365 

1) Select and copy the diagram from the .vsd file so that it’s on the clipboard. 366 

2) In Word, with your cursor at the diagram insertion point, on the Home menu select the down 367 
arrow under Paste and select Paste Special.  368 

3) Select Picture (Windows Metafile) or Picture (Enhanced Metafile), and then click OK.  369 

4) Look at the inserted figure to be sure that it's OK. 370 

NOTE  Use Enhanced Metafile if the .vsd image contains any special symbol-type characters. It takes more 371 
storage for enhanced metafiles, so that's the drawback of using it. It doesn't hurt to specify the Enhanced Metafile 372 
format if you're not sure if the art, such as a class diagram, includes special characters. 373 
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7.2  Tables 374 

This template contains a default table style called DMTF Table. It has the proper line weights and width 375 
pre-defined for typical DMTF tables. Sometimes, during the course of adding and deleting rows, the table 376 
formatting gets messed up. To automatically format a table using the DMTF Table table style, follow this 377 
procedure: 378 

1) Select the table that you want to format. (This activates a new menu.)  379 

2) Under Table Tools, click the Design tab.  380 

3) In the Table Styles group, click the More button (down arrow with a line over it) and you will see 381 
a lot of tables. Scroll to the top of these tables and you will see a Custom label with one table 382 
under it. This is the DMTF Table style, though it's not obviously labeled as such.  383 

4) Click this table style to apply it to the table.  384 

5) In the Table Style Options group to the left of the Table Styles group, check all six checkboxes.  385 

NOTE  The text in the table column headings should be bold. Although the DMTF Table style specifies bold text in 386 
headings, it doesn’t always work. You might have to highlight the table heading row and click the bold icon. 387 

8. Template support 388 

If you have questions about how to use this template or requests for updates, send an email to 389 
DMTF.Support@brightleafgroup.com. 390 

 391 

 392 
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Abstract 393 

 394 

<Provide a short statement (one paragraph) about what the white paper describes.> 395 

<Provide a short statement (one paragraph) about the intended target audience of the white paper.> 396 
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Foreword 397 

The DMTF Template (DSP1000) was prepared by the <DMTF Editing Body> Working Group. 398 

DMTF is a not-for-profit association of industry members dedicated to promoting enterprise and systems 399 
management and interoperability. For information about the DMTF, see http://www.dmtf.org. 400 
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Introduction 408 

The information in this specification should be sufficient for a provider or consumer of this data to 409 
unambiguously identify the classes, properties, methods, and values that shall be instantiated to 410 
subscribe, advertise, produce, or consume an indication using the DMTF Common Information Model 411 
(CIM) Schema. 412 

The target audience for this specification is implementers who are writing CIM-based providers or 413 
consumers of management interfaces that represent the components described in this document. 414 

Document conventions 415 

Typographical conventions 416 

The following typographical conventions are used in this document: 417 

 Document titles are marked in italics. 418 

 ABNF rules are in monospaced font. 419 

ABNF usage conventions 420 

Format definitions in this document are specified using ABNF (see RFC5234), with the following 421 
deviations: 422 

 Literal strings are to be interpreted as case-sensitive Unicode characters, as opposed to the 423 
definition in RFC5234 that interprets literal strings as case-insensitive US-ASCII characters. 424 

Deprecated material 425 

Deprecated material is not recommended for use in new development efforts. Existing and new 426 
implementations may use this material, but they shall move to the favored approach as soon as possible. 427 
CIM service shall implement any deprecated elements as required by this document in order to achieve 428 
backwards compatibility. Although CIM clients may use deprecated elements, they are directed to use the 429 
favored elements instead.  430 

Deprecated material should contain references to the last published version that included the deprecated 431 
material as normative material and to a description of the favored approach.  432 

The following typographical convention indicates deprecated material: 433 

DEPRECATED  434 

Deprecated material appears here.  435 

DEPRECATED  436 

In places where this typographical convention cannot be used (for example, tables or figures), the 437 
"DEPRECATED" label is used alone. 438 

Experimental material 439 

Experimental material has yet to receive sufficient review to satisfy the adoption requirements set forth by 440 
the DMTF. Experimental material is included in this document as an aid to implementers who are 441 
interested in likely future developments. Experimental material may change as implementation 442 
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experience is gained. It is likely that experimental material will be included in an upcoming revision of the 443 
document. Until that time, experimental material is purely informational. 444 

The following typographical convention indicates experimental material:  445 

EXPERIMENTAL  446 

Experimental material appears here.  447 

EXPERIMENTAL  448 

In places where this typographical convention cannot be used (for example, tables or figures), the 449 
"EXPERIMENTAL" label is used alone. 450 



DSP1000  DMTF Template 

Version 1.2.3 <Document Status> — DMTF Confidential 19 
 

DMTF Template  451 

1 Scope 452 

 453 

2 Normative references 454 

The following referenced documents are indispensable for the application of this document. For dated or 455 
versioned references, only the edition cited (including any corrigenda or DMTF update versions) applies. 456 
For references without a date or version, the latest published edition of the referenced document 457 
(including any corrigenda or DMTF update versions) applies. 458 

DMTF DSP0004, CIM Infrastructure Specification 2.7, 459 
http://www.dmtf.org/standards/published_documents/DSP0004_2.7.pdf 460 

DMTF DSP0215, Server Management Managed Element Addressing Specification 1.0, 461 
http://www.dmtf.org/standards/published_documents/DSP0215_1.0.pdf 462 

DMTF DSP0223, Generic Operations 1.0, 463 
http://www.dmtf.org/standards/published_documents/DSP0223_1.0.pdf 464 

DMTF DSP0228, Message Registry XML Schema 1.0, 465 
http://www.dmtf.org/standards/published_documents/DSP0228_1.0.pdf 466 

DMTF DSP1001, Management Profile Specification Usage Guide 1.1, 467 
http://www.dmtf.org/standards/published_documents/DSP1001_1.1.pdf 468 

DMTF DSP1033, Profile Registration Profile 1.0, 469 
http://www.dmtf.org/standards/published_documents/DSP1033_1.0.pdf 470 

DMTF DSP1053, Base Metrics Profile 1.1, 471 
http://www.dmtf.org/standards/published_documents/DSP1053_1.1.pdf 472 

DMTF DSP1054, Indications Profile 1.2, 473 
http://www.dmtf.org/standards/published_documents/DSP1054_1.2.pdf 474 

DMTF DSP8016, WBEM Operations Message Registry 1.0, 475 
http://schemas.dmtf.org/wbem/messageregistry/1/dsp8016_1.0.xml 476 

DMTF DSP8020, Message Registry XML Schema Specification 1.0, 477 
http://www.dmtf.org/standards/published_documents/DSP8020_1.0.xsd 478 

IETF RFC5234, ABNF: Augmented BNF for Syntax Specifications, January 2008, 479 
http://tools.ietf.org/html/rfc5234 480 

ISO/IEC Directives, Part 2, Rules for the structure and drafting of International Standards, 481 
http://isotc.iso.org/livelink/livelink.exe?func=ll&objId=4230456&objAction=browse&sort=subtype 482 

The Open Group, "Regular Expressions" in The Single UNIX ® Specification, Version 2, 483 
http://www.opengroup.org/onlinepubs/7908799/xbd/re.html 484 

http://www.dmtf.org/standards/published_documents/DSP0004_2.7.pdf
http://www.dmtf.org/standards/published_documents/DSP0215_1.0.pdf
http://www.dmtf.org/standards/published_documents/DSP0223_1.0.pdf
http://www.dmtf.org/standards/published_documents/DSP0228_1.0.pdf
http://www.dmtf.org/standards/published_documents/DSP1001_1.1.pdf
http://www.dmtf.org/standards/published_documents/DSP1033_1.0.pdf
http://www.dmtf.org/standards/published_documents/DSP1053_1.1.pdf
http://www.dmtf.org/standards/published_documents/DSP1054_1.2.pdf
http://schemas.dmtf.org/wbem/messageregistry/1/dsp8016_1.0.xml
http://www.dmtf.org/standards/published_documents/DSP8020_1.0.xsd
http://tools.ietf.org/html/rfc5234
http://isotc.iso.org/livelink/livelink.exe?func=ll&objId=4230456&objAction=browse&sort=subtype
http://www.opengroup.org/onlinepubs/7908799/xbd/re.html
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3 Terms and definitions 485 

In this document, some terms have a specific meaning beyond the normal English meaning. Those terms 486 
are defined in this clause. 487 

The terms "shall" ("required"), "shall not", "should" ("recommended"), "should not" ("not recommended"), 488 
"may," "need not" ("not required"), "can" and "cannot" in this document are to be interpreted as described 489 
in ISO/IEC Directives, Part 2, Annex H. The terms in parenthesis are alternatives for the preceding term, 490 
for use in exceptional cases when the preceding term cannot be used for linguistic reasons. Note that 491 
ISO/IEC Directives, Part 2, Annex H specifies additional alternatives. Occurrences of such additional 492 
alternatives shall be interpreted in their normal English meaning. 493 

The terms "clause", "subclause", "paragraph", and "annex" in this document are to be interpreted as 494 
described in ISO/IEC Directives, Part 2, Clause 5. 495 

The terms "normative" and "informative" in this document are to be interpreted as described in ISO/IEC 496 
Directives, Part 2, Clause 3. In this document, clauses, subclauses, or annexes labeled "(informative)" do 497 
not contain normative content. Notes and examples are always informative elements. 498 

The terms defined in DSP0004, DSP0223, and DSP1001 apply to this document. The following additional 499 
terms are used in this document. 500 

3.1  501 
<term> 502 

<term definition> 503 

4 Symbols and abbreviated terms 504 

The abbreviations defined in DSP0004, DSP0223, and DSP1001 apply to this document. The following 505 
additional abbreviations are used in this document. 506 

4.1  507 
<abbrev. term> 508 

<abbrev. term definition> 509 

5 Conformance 510 

 511 
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6 Synopsis 512 

6.1 Profile attributes 513 

Profile name: <RegisteredProfileName> 514 

Version: 1.0.0 515 

Organization: DMTF  516 

Profile type: 517 

Schema version:  518 

Central class adaptation:  519 

Scoping class adaptation:  520 

Scoping algorithm:  521 

6.2 Summary 522 

 523 

6.3 Related profiles 524 

Table 1 lists profiles that are related to this profile. 525 

Table 1 – Related profiles 526 

Profile reference name Profile name Organization Version Relationship Description 

      

<profile reference> <reg.name of 
referenced 
profile> 

<reg.org> <reg.ver
sion.m.
n> 

<requirement>  

6.4 Referenced registries 527 

Table 2 lists the message registries referenced in this profile. 528 

Table 2 – Referenced message registries 529 

Registry reference name 
Registryidenti
fier Organization Version Description 

     

   <reg.versio
n.m.n> 

 

6.5 Features 530 

Table 3 lists the features defined in this profile. 531 
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Table 3 – Features 532 

Feature name Granularity Requirement Description 

    

    

6.6 Adaptations 533 

Table 4 lists the class adaptations that are defined in this profile. 534 

Table 4 – Adaptations 535 

Adaptation Elements Requirement Description 

Classes 

    

    

    

    

    

Indications 

    

    

    

    

    

6.7 Use cases 536 

Table 5 lists the use cases defined in this profile. 537 

Table 5 – Use cases 538 

Use case name Description 

  

  

7 Description 539 

 540 

<Insert Figure Here> 541 

Figure 1 – <Profile Name Here>: Class adaptation diagram 542 
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8 Implementation 543 

8.1 General 544 

 545 

8.2 Features 546 

8.2.1 Feature: <Feature name> 547 

8.2.1.1 Feature description 548 

 549 

8.2.1.2 Feature discovery 550 

 551 

8.2.2 Feature: <Feature name> 552 

8.2.2.1 Feature description 553 

 554 

8.2.2.2 Feature discovery 555 

 556 

8.3 Adaptations 557 

8.3.1 General requirements 558 

 559 

8.3.2 <Adaptation name> 560 

8.3.2.1 General 561 

 562 

8.3.2.2 Implementation requirements 563 

Table 6 lists the element requirements of the <Adaptation name> adaptation. 564 

Table 6 – <Adaptation name>: Element requirements 565 

Element Requirement Description 

Base elements 
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Element Requirement Description 

Properties 

   

   

   

   

Methods 

   

   

   

Operations 

   

   

   

8.3.2.3 Property: <property name> 566 

 567 

8.3.2.4 Property: <property name> 568 

 569 

8.3.2.5 Method: <method name> 570 

 571 

Table 7 specifies the error reporting requirements for the <method name> method.  572 

Table 7 – <method name>: Error reporting requirements 573 

Error reporting mechanism Description 

  

  

  

  

8.3.2.6 Operation: <operation name> 574 

Table 8 specifies the error reporting requirements for the <operation name> operation.  575 

Table 8 – <operation name>: Error reporting requirements 576 

Error reporting mechanism Description 
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Error reporting mechanism Description 

  

  

  

8.3.3 Subclause Level 2 w/ TOC Entry 577 

8.3.3.1 Subclause Level 3 w/ TOC Entry 578 

8.3.3.1.1 Subclause Level 4 w/ TOC Entry 579 

8.3.3.1.1.1 Subclause Level 5 w/ TOC Entry 580 

9 Use cases 581 

9.1 <Use case name 1> 582 

 583 

9.1.1 Preconditions 584 

 585 

9.1.2 Flow of activities 586 

1)  587 

–  588 

–  589 

2)  590 

–  591 

–  592 

9.1.3 Postconditions 593 

9.1.3.1 Success 594 

 595 

9.1.3.2 Failure 596 

 597 
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ANNEX A 598 

(normative) 599 

 600 

 601 

<insert annex title here> 602 

A.1 Annex Subclause Level 1 w/TOC entry 603 

Table A-1 – <Table Title Here> 604 

   

   

   

A.1.1 Annex Subclause Level 2 w/TOC entry 605 

A.2 Annex SubclauseLevel 1 w/TOC entry 606 

A.2.1 Annex Subclause Level 2 w/TOC entry 607 

<Insert Figure Here> 608 

Figure A-1 – <Figure Title Here> 609 
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ANNEX B 610 

(informative) 611 

 612 

 613 

Change log 614 

Version Date Description 

 <yyyy-mm-
dd> 

<Include one row for each published release and each member review release (that 
is: Work in Progress, Draft DMTF Standard, DMTF Standard). In this “Description” 
column, note the document’s status and provide a summary of the changes since the 
previous release. The first release should not include a change summary. The 
summary of changes should be understandable for external readers that have no 
access to DMTF internal material.> 

1.2.2 2013-04-02 Various updates to custom styles (for example, hiding unused styles; removing font 
size from fixed font and hyperlink to make styles usable in other areas besides 
normal text; increasing space before/after table text) 

1.2.3 2013-11-19 Replaced  DMTF logo on cover page with new version created and approved by 
Marketing Committee. 

   



DMTF Template  DSP1000 

 

28 <Document Status> — DMTF Confidential Version 1.2.3 
 

Bibliography 615 

DMTF DSP4004, DMTF Release Process 2.4, 616 
http://www.dmtf.org/sites/default/files/standards/documents/DSP4004_2.4.pdf 617 

<owning org><doc number>, <doc title and version or date>, 618 
<hyperlink> 619 

 620 

http://www.dmtf.org/sites/default/files/standards/documents/DSP4004_2.4.pdf

	1. How to use this template (general instructions)
	1.1 General
	1.2 Storing the template (.dotx) file
	1.3 Ensuring that your document uses the template
	1.4 Using the optional macros template
	1.4.1 Why use the optional macros template


	1.4.2 How to apply the optional macros template as a global template
	1.4.2.1 Enable the DSP1000macros_m.n.u.dotm global template
	1.4.2.2 Disable the DSP1000macros_m.n.u.dotm global template

	1.5 Attaching the DSP1000_m.n.u.dotx template to an existing document
	1.6 Using the organizer to copy the template styles to your document
	1.7 Using the variables defined in the template
	1.8 Updating properties and fields in a document
	1.8.1 To update the value for a single field
	1.8.2 To update all of a document’s properties and fields

	1.9 Using bookmarks and hyperlinks for references to other documents
	1.9.1 To add a bookmark
	1.9.2 To add a hyperlink
	1.9.3 Conventions for bookmarks

	2. Using this template to create a DMTF profile
	3. Using this template to create a DMTF specification
	4. Using this template to create a DMTF white paper
	5. Guideline for using capital letters in headings and figure and table titles
	6. Document footers
	7. Helpful Hints for Figures and Tables
	7.1  Figures

	7.2  Tables
	8. Template support
	Acknowledgments
	Document conventions
	1 Scope
	2 Normative references
	3 Terms and definitions
	4 Symbols and abbreviated terms
	5 Conformance
	6 Synopsis
	6.1 Profile attributes
	6.2 Summary
	6.3 Related profiles
	6.4 Referenced registries
	6.5 Features

	6.6 Adaptations
	6.7 Use cases
	7 Description
	8 Implementation
	8.1 General
	8.2 Features
	8.2.1 Feature: <Feature name>
	8.2.1.1 Feature description
	8.2.1.2 Feature discovery

	8.2.2 Feature: <Feature name>
	8.2.2.1 Feature description
	8.2.2.2 Feature discovery


	8.3 Adaptations
	8.3.1 General requirements
	8.3.2 <Adaptation name>
	8.3.2.1 General
	8.3.2.2 Implementation requirements



	8.3.2.3 Property: <property name>
	8.3.2.4 Property: <property name>
	8.3.2.5 Method: <method name>
	8.3.2.6 Operation: <operation name>
	8.3.3 Subclause Level 2 w/ TOC Entry
	8.3.3.1 Subclause Level 3 w/ TOC Entry
	8.3.3.1.1 Subclause Level 4 w/ TOC Entry
	8.3.3.1.1.1 Subclause Level 5 w/ TOC Entry



	9 Use cases
	9.1 <Use case name 1>
	9.1.1 Preconditions
	9.1.2 Flow of activities
	9.1.3 Postconditions
	9.1.3.1 Success
	9.1.3.2 Failure



	ANNEX A  (normative)   <insert annex title here>
	A.1 Annex Subclause Level 1 w/TOC entry
	A.1.1 Annex Subclause Level 2 w/TOC entry

	A.2 Annex SubclauseLevel 1 w/TOC entry
	A.2.1 Annex Subclause Level 2 w/TOC entry


	ANNEX B  (informative)   Change log

